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Welcome to the Mortgage Designer on-line documentation and help file.      Mortgage 
Designer is a Windows 3.x application and uses standard Windows techniques.    This 
document covers areas that are specific to Mortgage Designer.    If you need information 
about using Windows, please refer to your Microsoft Windows documentation.

Mortgage Designer helps you make informed decisions on what probably will be the 
largest investment of your life--your home.    Mortgage Designer is the quickest way to 
calculate all aspects of home mortgage loans. 

Procedures

To make best use of Mortgage Designer, your first step is to select the File menu, 
Preferences... command.    Enter the principal, interest rate, term of the loan (in 
years), payment options (how often payments are made), and start date.    Then press
the Payment button to display the normal payment required for the loan.    If you want
to save these loan parameters for future use, select the Database..., Set as Default 
command.    Each time you start Mortgage Designer, these default loan parameters
are read from the database file (MD.INI) if it exists.

Once you've entered the basic mortgage parameters, you can calculate the loan's 
remaining balance (if you've been paying on it for a while) by selecting the Calculate 
menu, Remaining Balance command.    To find the cost of the mortgage over its full 
term, select the Calculate menu, Cost of Loan command.    You can have Mortgage 
Designer compute any one of the four parameters of a loan by selecting the 
Calculate menu, Missing Variable command.

Mortgage Designer will display or output amortization schedules by selecting the 
Reports menu, Amortization Schedule command.    In addition to viewing them on the 
screen, you can optionally send amortization schedules to a file or printer.    To 
perform "what if" analyses of different mortgages, use the Reports menu, Mortgage 
Comparisons... command.

Help

Help for Mortgage Designer is accessed two ways:

- Pressing F1 (when no menu is highlighted)

- Using the Help pulldown menu

General help areas are listed in the index.

Notes:    Mortgage Designer will calculate any type of loan (not just mortgages) as long as the term of the loan is 
in years.    Use it to analyze your car loan, your business loan, or any situation where you are borrowing or lending 
money.    In any case, Mortgage Designer can save you money and make you an informed consumer.

Mortgage Designer is compatible with Microsoft Windows versions 3.0 and 3.1.





Help Usage Overview
Mortgage Designer provides several ways of accessing its built-in help.    They are:

1.    Accessing the help through the pulldown menu options available on the main menu.    
This provides an easy way for you to call up the general area you are interested in.
2.    Pressing F1 when NOT in a dialog box which brings up general help.    This will bring up 
an index for the help.
3.    Using the help button available on many of the dialog boxes for very specific help.    This 
is the best way to get help.    The help will be specific and directly related to the current 
dialog box.
4.    Pressing F1 when in a dialog box or message box.    That will bring up this screen.

See the commands help screen for a quick index into all the different major commands.    
Please note that you can use the help system to search for specific topics.    An extensive 
cross reference of search topics is built into Mortgage Designer.



Mortgage Designer Index
To display a topic, click on the underlined title.

Commands
Help
Menus
Procedures



Preferences Usage Help
The preferences area of Mortgage Designer allows you to save selected defaults to a file 
called MD.INI that will be automatically loaded each time you start up Mortgage Designer. 

In the Mortgage Information dialog box you must enter the various parameters of the loan.

Principal Enter the full amount of the loan principal, up to 9 digits.    Do 
not enter a dollar sign ("$") or commas.    Principals from 
$100.00 to $999,999,999 are supported at all interest rates and
loan lengths.

Interest Rate Enter the annual interest rate as a percentage.    For example, if 
the annual interest on the loan is 9 3/4%, type in 9.750.    Do not
enter a percent sign ("%").    Interest rates from 0.100% to 
50.000% are allowed.

Mortgage Length Enter the term of the loan in years.    The term must be a 
number from 1 to 50 years.    Months were not used because 
they can't be divided evenly using the two week repayment 
option!    Also, mortgages are almost always at least a minimum
of five years.

Payment Options Select the frequency of payments, either every two weeks, 
twice a month, monthly, quarterly, semiannual, or once a year.   
This option and the loan start date will be used to calculate the 
dates used for the amortization table.

Loan Starts Enter the date the loan starts.    Date format is MM/DD/YYYY.    
Example:    for 1 Dec 1991 enter 12/01/1991.    The loan start 
date must be between    1 Jan 1900 and 31 Dec 2100.    

Note:    The first payment date for the amortization table for 
twice monthly payments will be adjusted to the 1st and 15th of 
the following month.    Monthly payments will fall on the same 
day    each month (or last day of the month whichever is less) 
starting one month after the loan start date.

Comments The comments area allows you to add a string of up to 20 
characters by which you can customize the loan.    All leading 
and trailing spaces will be removed in order to allow it to align 
correctly for amortization reports.

PITI Defaults The PITI area allows you to specify taxes and insurance on a 
mortgage by mortgage basis.

Tax Brackets Specify the tax brackets on a loan by loan basis.

When all the parameters of the loan have been entered, press the Payment button or the 
Enter key to calculate and display the payment amount.    The Payment function estimates 
your P&I and also the PITI.    For the PITI estimate, Mortgage Designer assumes the taxable
value of the property is the full principal value.    Use the Calculate... PITI section for 
additional capability.    To close the Mortgage Information dialog box, press the Done button.   



You will also notice that this dialog box provides access to a database of loan information.    
When you select the database option, another dialog box will be displayed.    Using the 
database area you can specify default loan values for a virtually unlimited number of loans 
complete with comments on their purpose.

Notes: 

1.    The government is constantly changing tax laws.    Because of this, we decided to make the tax brackets user 
installable to allow the user to keep pace with tax bracket changes.

2.      Watch this area in the future.    As we get more user feedback, we will expand this area to include additional 
items.    If you have suggestions please write us and let us know how to improve Mortgage Designer.



Database Usage Help
The database area provides access to data on multiple loans with the ability to specify the 
initial defaults for startup.    The main functional areas are:

Set as Default - Highlight a record in the "Loan Database Records" list box and then use this 
option to specify the record as the inital defaults for Mortgage Designer.    

Add Record - Add a new record to the database which consists of the current defaults.    The 
record will be added to the end of the current database.

Delete Record - Highlight a record in the "Loan Database Records" list box and then use this 
option to delete or remove the highlighed record.

Use and Exit! - Highlight a record in the "Loan Database Records" list box and then use this 
option to load the highlighted information and use it as the current defaults.

Notes: 

1.    The default record for startup will have an * as the first character in the list box.    Mortgage Designer will 
automatically use the record with an * if one is specified.    Specifying a default record is optional.

2.    The delete record option is a two step process that takes place transparent to you UNLESS an error is 
encountered.    The first step is for the record to be marked as deleted.    The second step is for the 
preferences/database file (MD.INI) to be packed and the file size reduced.    

3.    The records in the database are displayed in the listbox in a fixed format.    The display format is:

* if startup default, record number, comment, principal, interest rate, term, payments per year (ex. two week is 26),
and loan start date (MM/DD/YYYY).    Tax brackets, taxes, and insurance are also contained in the record but aren't 
displayed due to display and printer width limitations.

4.    The maximum width of the comment field is limited to 20 characters throughout Mortgage Designer because 
of the requirement to display it on a single line with the rest of the database record.    This should be more than 
enough to uniquely identify the records.    



Calculate Remaining Balance Help
When you have entered the number of payments made, press the Calculate button or the 
Enter key to calculate and display the payment amount, principal paid, interest paid and 
loan balance.    To close the Analysis dialog box, press the OK button or the Enter key.    You 
may change the number of payments made and press Calculate or Enter as often as you 
wish to see the effect on your loan balance.    To close the Calculate Remaining Balance 
dialog box, press the Done button.



Calculate Equity vs Balance Help
When you have entered the number of payments made and the current estimated value, 
press the Calculate button or the Enter key.    A dialog box will appear with a total picture of 
where you stand on the mortgage.    To close the Analysis dialog box, press the OK button or 
the Enter key.    You may change the number of payments made/current value and press 
Calculate or Enter as often as you wish to see the effect on your loan balance.    To close the 
Calculate Equity vs Balance dialog box, press the Done button.

Notes: 

1.    The equity is the current value - principal + amount of loan paid off.    When you calculate the equity, the dialog 
box will have one of the fields showing estimated equity.    This number can be negative if you owe more on the 
property than it is worth.    When the number is negative, a minus sign will be shown in front of the equity.

2.    The percent equity is the equity*100/principal.    Like the equity, it can also be negative if you owe more than 
the property is worth.



Calculate PITI Help
The calculate Principal, Interest, Taxes, and Insurance (PITI) function attempts to give you a 
complete picture of what your mortgage payment will be.    When you have entered the tax 
and insurance values, press the Calculate button or the Enter key.    A dialog box will appear 
with the calculated PITI.    To close the Calculate PITI dialog box, press the OK button or the 
Enter key.    You may change the tax/insurance values and press Calculate or Enter several 
times to see the effect on your mortgage Payment.    To close the Calculate PITI dialog box, 
press the Done button.

Notes: 

1.    Many things alter your total mortgage payment.    PITI takes into account the majority of the items, but is not all 
inclusive.    

2.    Since the tax and insurance information could apply to a wide variety of loans, it is stored as part of the 
program defaults.    See the program defaults area under the File area for a complete listing of program defaults.

3.    The calculated tax and insurance are based on the taxable property value when you select the percentage 
option.



Calculate Missing Variable Help
When the Mortgage - Find Missing Information dialog box is displayed, it will contain all the 
information available from the Mortgage Designer preferences/database loan file (MD.INI) 
if it exists.    To calculate a new value for any of the variables, perform the following steps:

1. Modify any three of the four variables (Principal, Interest Rate, Term, or Payment). 
You also have the option of specifying whether the payments are every two 
weeks, twice a month, monthly, quarterly, semiannual, or once a year by 
selecting the desired item.

2. Select the item you want Mortgage Designer to calculate from the Missing Item 
group.

3. Press the Calculate button or the Enter key to calculate and display the new 
values for the modified parameters.    The pie chart off to the right will then be 
updated to reflect the new principal and interest percentages for the life of the 
loan.

What if you want to compare multiple mortgage choices?    Use the Log to File option to 
save the different sets of data you generate.    The data will be saved in a file (What-Ifs.Log).  
You can then view the file or delete it and start over with a new group of options for 
comparison.    The size of the log file is limited only by available free disk space.    Since 
viewing a large number of items in a list box is difficult, we recommend deleting the old log 
file and starting a new one whenever you start working with a new group of options.    

Also located on this dialog box are two buttons that allow you to work with the global 
program defaults.    The Pgm Default group allows you to either overwrite the displayed 
values with the global program defaults (Use Here) or change the global mortgage defaults 
to those shown (Chng Pgm).    

To close the Mortgage - Find Missing Information dialog box, press the Done button.

Notes: 

1.    It is not necessary to clear the value from the box containing the variable you want to calculate.    Mortgage 
Designer will ignore the contents of that box when it calculates the item selected in the Missing Item group.

2.  Want to save money?    The pie chart shown on the right side of the dialog box is updated after each 
calculation to show the percentage of the total loan payments that goes toward principal (black) and interest (red).   
As a borrower, normally your goal will be to minimize the amount of interest you pay over the life of a loan.    This 
pie chart can graphically show you how to save money.    As you are running through the various "What if?" options, 
try to minimize the red portion of the pie chart.    If you are the loaner, you want to maximize the red portion of the 
pie chart



Calculate Mortgage Refinance Help
Mortgage Designer will compare two mortgages of different repayment options allowing 
you to get a feel for the advantages of refinancing.    The old mortgage (existing mortgage) 
and the new mortgage terms are entered into the two mortgage areas shown on the dialog 
box.    The time intervals of the two mortgages must overlap and the new mortgage balance 
be less than the old balance at some point for a break even to occur.

The new mortgage principal should include all the costs of refinancing plus the old mortgage
amount carried over.    Typical refinancing costs run 3-5% of the amount to refinance.    

Mortgage Designer calculates the refinance break even point based on the balance at the 
end of each payment.    You have the option to either apply the payment difference (if 
positive) to further reduce the principal.

To close the Mortgage Refinance - Break Even Analysis dialog box, press the Done button.



Mortgage Break Even Analysis Help
The dialog box displayed on the screen provides the estimated break even point and two list 
boxes showing payments and balances.    The left list box shows your current mortgage.    
The right list box shows the new or projected mortgage.    

Each of the list boxes contains a complete list for all mortgage payments.    The format for 
the list boxes is payment number, date for the payment, and the balance.

Mortgage Designer uses a simplified method for calculating the break even point for 
mortgage refinancing.    Payment reductions are optionally reflected into the break even 
analysis if the new payment is less than the existing payment (adjusted to the same 
payments per year) and you choose to reduce the principal further.    Break even analysis 
looks ONLY at principal reduction.    It assumes you are not re-investing the payment into a 
savings account, CD, or other interest producing vehicle.    This should cover the majority of 
cases.

The new mortgage reduce principal option applies the payment difference to further reduce 
the mortgage balance.    The new mortgage payment must be less than the old mortgage 
payment for this option to work.    To be able to calculate the payment differences, the old 
mortgage is re-computed at the same repayment interval as the new mortgage.    Otherwise,
there would be no way to compare the two payments.

Mortgage Designer goes through extensive calculations to come up with the displayed 
data.    Please be patient with us if it takes a couple of seconds to calculate.

Notes: 

1.    The break even point is calculated by looking at each payment of the new mortgage.    The first new mortgage 
payment that generates a balance less than or equal to a balance on the old mortgage of the same or earlier date 
is defined as the break even point.

2.    The larger term repayment periods introduce date inaccuracies.    For example, when the yearly repayment 
option is selected on either loan, the entire year is checked for a match.

3.    The date calculations may add some inaccuracies to the break even point.    All mortgage repayments options of
one month or twice a month are assumed to have their first payment due one month after the mortgage is taken 
out.    This causes the principal to be reduced more on the first payment on monthly mortgage payments over 2x 
month mortgage payments.    This difference will cause the break even point to appear on the first payment, all 
other factors being the same.



Variable Rate Mortgage Help
Mortgage Designer will calculate a variable rate mortgage with up to 10 different rates 
during the life of the mortgage.    Once you have entered the rate changes in the terms 
group box on the right of the dialog box, select the calculate function to generate the 
amortization schedule.

The calculate function provides you with a detailed amortization schedule showing every 
rate change, payments at each of the different interest rates, remaining balance, and an 
average interest rate over the life of the mortgage.

There are a few precautions you should take when using the variable rate mortgage 
calculations.

1.    Enter all term/rate number pairs in the Term1-Term10 areas.    Order is not important.    
For example, if you specify Term1 to start at year 5 at 10.000% and Term2 to start at year 1 
at 8.000%, Mortgage Designer will automatically sort the numbers on the term before 
performing the calculations.

2.    One of the terms must start out the mortgage with an initial rate.    By this we mean that 
one of the terms (Term1-Term10) must contain the year 1 with the initial mortgage interest 
rate.



Interest Rate Conversion Help
Mortgage Designer will help you convert between different interest rate and mortgage 
compounding periods.    Where would you need it?    Assume you have a mortgage where the
payments are made monthly but the interest is compounded twice a month.    What is your 
real interest rate?    This area of Mortgage Designer helps you convert between the 
different payment/compounding periods.

Mortgage Designer can help you figure out what terms are to your best advantage.    
Would you rather have a 8.000% mortgage with the interest rate compounded monthly or a 
8.100% effective interest rate?    Use this area to find out which one is best for you.    An 
informed choice can help you save money on your mortgage!

This dialog has two basic groups -- Current Rate and Converted Rate.    The two groups are 
always equal after you press the solve button.    

Notes: 

1.    Mortgage Designer will solve for any interest up to 99.999%.    The interest conversion routines should be 
accurate for the entire range of possible interest rate values.

2.    This dialog box displays the effective interest at the bottom of the dialog box.    The effective interest is the 
same as the interest compounded at a yearly rate.

3.    The initial defaults for the interest calculations is based on the preferences you have when you enter this dialog 
box.



Amortization Schedule Help
An amortization schedule shows at a glance exactly how much of your mortgage payment 
goes to principal and interest, and the remaining balance on the loan for each payment.    It 
also summarizes the loan amount, term, interest rate and normal payment. This option in 
Mortgage Designer complements the Calculate menu, Remaining Balance command, 
which calculates and displays only the principal, interest and remaining balance for any 
single payment period.

Use the numeric keypad keys to scroll around within the list box.    

Notes:    

1.    The final payment will be different than the normal payment to compensate for the normal payment being 
rounded to the nearest cent.    To calculate the final payment, add or subtract (as appropriate) the remaining 
balance at the end of the schedule from the normal payment.

2.    Payment dates are determined differently based on the type of loan you select.

        a.    Every two weeks - Each payment will be 14 days from the last one.    The first payment will be due 14 days 
after the loan start date.

        b.    Twice a month - The dates are shown as the 1st and 15th of the month.    The first payment month is the 
month following the loan start date.

        c.    Monthly - The payments will fall on the same day each month unless there aren't that many days in the 
month.    In that case, the payment will be due the last day of the month.    February is considered to always have 28
days for purposes of payment due dates.    This avoids the problem of leap years where sometimes the payment 
would be due February 28th and sometimes February 29th.

        d.    Quarterly - Due every three months and will fall on the same day each month.

        d.    Semiannual - Due every six months and will fall on the same day each month.

        e.    Yearly - Payment will occur each year on the same day.



Print (export) Help
The Print dialog box allows you to specify where to send output and which lines of the listbox
to include in the output.

Output To? Selecting Printer will send the output to your current printer.    If 
you have more than one printer installed in Windows, or if you 
wish to customize the format of the output, you may use the 
Printers option in the Windows Control Panel application to 
select or setup your printer.

Selecting File will send the output schedule to a file of your 
choice.

Selecting Clipboard will send the to the clipboard.    You can then
use notepad or any Windows editor to touch up the listing.    Be 
sure to use a fixed width font like Courier or Courier New when 
you paste it into your application.    The numbers may not line 
up if you use a proportional width font.

Which Lines? This selection defaults to include all lines of the listbox.    If you 
wish to output only a subset, select First, then Last, entering the
range of lines you want included.

Add Heading: Mortgage Designer will automatically add a heading to the 
top of the listing.    This will contain the mortgage specifics and 
comments.    To disable this feature, unmark the add heading 
box.

After selecting the destination and range of payments to output, press the OK button or the 
Enter key to send the listing schedule to the printer or file.    If you selected Output to File, a 
dialog box will display to allow entering a filename.    After entering a filename (or accepting 
the default), press the OK button or the Enter key to begin sending the amortization 
schedule to the selected file.    To close the Output to File dialog box without saving the 
schedule to a file, press the Cancel button.    This action will also close the Output 
Destination dialog box and return you to the main window.    To close the Output Destination 
dialog box without taking any action, press the Cancel button.

Note:    Mortgage Designer must read the contents of the listbox to build the lines that will be exported.    To do 
this, the first listbox line must be read and then deleted so that the next one can be accessed.    This process may 
be a little slow under Windows 3.0 with an annoying flicker.    Windows 3.1 is much more efficient in this area.



Mortgage Designer Commands
To get help with a particular command, choose the appropriate menu.

File Menu Commands
Preferences...
Exit

Calculate Menu Commands
Remaining Balance...
Equity vs Balance...
Cost of Loan
PITI...
Missing Variable...
Mortgage Refinance...
Variable Rate Mortgage...
Interest Conversion...

Reports Menu Commands
Amortization Schedule...
Mortgage Comparisons...

Tax Time    Menu Command
Yearly P and I...
Yearly Tax Savings...

F1 = Help Menu Commands
Overview
Index
Commands
Print Invoice
About Mortgage Designer



File Menu Help
The File menu allows you to enter and save information about your mortgage.    All other 
menu commands in Mortgage Designer operate on the information you enter here about 
the parameters of your loan.

Preferences... Displays the Preferences dialog box.    This command provides 
access to a complete database of loans.    It allows you to save 
information entered in the Mortgage Information dialog box so 
that it may be recalled when Mortgage Designer starts.    The 
mortgage defaults which are shown under Preferences... will be 
saved as a record in the file called MD.INI in the default 
directory.

Exit Exits Mortgage Designer.

When you start Mortgage Designer, it automatically recalls the information entered in the 
Mortgage Information dialog box, if it was previously saved using the database set default 
command. To exit the File menu without taking any action, click or drag the mouse 
anywhere outside the menu, or press the Esc (escape) key.



Calculate Menu Help
The Calculate menu allows you to compute various aspects of your mortgage.

Remaining Balance... Displays the Calculate Remaining Balance dialog box.    Given 
how many payments have been made, this command provides 
the value of the normal payment, the investment in principal 
and interest, and the balance due on the mortgage.

Equity vs Balance... Displays the Calculate Equity vs Balance dialog box.    Given how
many payments have been made and the estimated value of 
the property, this command provides an estimated overall value
for the property.    It takes into account the paid down principal 
and estimated market value for the property.

Cost of Loan Displays the Cost of Loan dialog box containing the total of all 
payments, the original loan principal, and the difference 
between the two.

PITI... Displays the PITI dialog box.    It tries to estimate your total 
mortgage payment factoring in both taxes and insurance in 
addition to the normal principal and interest payments.

Missing Variable... Displays the Mortgage - Find Missing Information dialog box.    
Given any three of the four parameters needed to calculate a 
loan, this command calculates the missing parameter.    

Mortgage Refinance... Displays the Mortgage Refinance - Break Even Analysis 
dialog box.    You can compare an existing mortgage against a 
new mortgage.    Typically the new mortgage will be of higher 
principal but lower interest rate.    The crossover point for the 
principals can be calculated (the break even point).    

Var Rate Mortgage... Displays the Variable Rate Mortgage dialog box.    You can 
calculate variable rate mortgages with up to 10 rates during the
life of the loan.    An option is also provided to generate an 
amortization table showing all rate changes, payment changes, 
and the balance at the end of each payment.

Interest Conversion...Displays the Interest Conversion dialog box.    This function will 
quickly help you convert between different interest rate 
compounding and payment compounding peroids.

To exit the Calculate menu without taking any action, click or drag the mouse anywhere 
outside the menu, or press the Esc (escape) key.



Reports Menu Help
The Reports menu allows displaying an amortization schedule of your mortgage or 
comparing mortgage options by varying different parameters of the loan.

Amortization Schedule... Displays a complete amortization schedule for your 
mortgage.    The Mortgage Designer main menu is replaced 
by a new menu to allow navigating to all pages of the schedule 
and to output the schedule to a destination of your choice.

Mortgage Comparisons... Displays a table comparing the principal and interest you
entered in the Mortgage Information dialog box with four 
variations on both.

Principal is listed at the top of the each of the five columns on 
the right.    Your original principal is in the center column.    
Values for plus and minus 5% and 10% are shown in the two 
columns on either side of the original principal.

Interest is listed in the left column.    Your original interest is in 
the center row.    Values for plus and minus interest rates are 
shown in the two rows above and below the original interest 
rate.

To exit the Reports menu without taking any action, click or drag the mouse anywhere 
outside the menu, or press the Esc (escape) key.



F1=Help Menu Help
The F1 = Help menu brings up various types of help which make up the on-line 
documentation for Mortgage Designer.

Overview Provides an overview of Mortgage Designer.

Index Displays the help index.

Commands Displays the complete list of menu commands.

Print Invoice Prints an invoice for registering Mortgage Designer.    If you 
are evaluating the shareware version of the program, and you 
intend to make continued use of it, you are obligated to register
the program.    Improvements to Mortgage Designer can only 
be made if you support the shareware concept.    Shareware is 
not freeware or public domain software.    There are privileges 
and incentives to becoming a registered user.    Please read the 
README.DOC file for details.

About Mortgage Designer Displays a dialog box containing the current program 
version, copyright notice and obligatory head-swelling credits 
for the authors.

To exit the F1 = Help menu without taking any action, click or drag the mouse anywhere 
outside the menu, or press the Esc (escape) key.



Tax Time Menu Help
Mortgage Designer will calculate the amount of principal and interest paid on a yearly 
basis and an estimated tax savings due to having the mortgage.    This takes into account 
the different repayment options.    The calculations are quite extensive and may take a few 
seconds.    After the items are calculated for each year of the loan, they will be displayed in a
list box.

The list box which shows the information can be controlled by both the keyboard and mouse.
Simply scroll through the listing until you find the year(s) you are looking for. 



Estimated Yearly P & I
Mortgage Designer will calculate the amount of principal and interest paid on a yearly 
basis.    This takes into account the different repayment options.    The calculations are quite 
extensive and may take a few seconds.    After the items are calculated for each year of the 
loan, they will be displayed in a list box.

The list box which shows the information can be controlled by both the keyboard and mouse.
Simply scroll through the listing until you find the year(s) you are looking for. 

The list box displays for each year the total of the payments that went toward principal and 
interest.    



Estimated Yearly Tax Savings
Mortgage Designer will calculate the estimated amount of tax savings on a yearly basis.    
This takes into account the different repayment options.    The calculations are quite 
extensive and may take a few seconds.    After the items are calculated for each year of the 
loan, they will be displayed in a list box.

The list box which shows the information can be controlled by both the keyboard and mouse.
Simply scroll through the listing until you find the year(s) you are looking for. 

The list box displays figures for each year showing the amount of money saved depending 
on your tax situation.    The box lists figures for 15%, 28%, and 31%.    These are the default 
brackets and can be changed by the user.    As the brackets change between tax years, you 
can easily specify new defaults to keep pace with new tax laws.

Guessing at your potential tax savings is very difficult.    Mortgage Designer takes the 
approach of using only the 15%, 28%, and 31% of the interest for the years listed in the list 
box.    Many times the deductable mortgage interest may lower you from one tax bracket 
into another (for example, overall taxes drop from 31% to 28%).    Without extensive details 
from you, this factor could not be taken into account.

The Adj Pymt function on this dialog box will show you the estimated adjusted payments for 
the mortage using the potential tax savings.    This is calculated by the following formula:

Yearly Adjusted Payment = NP - YPTS/NPMDY where

PYMT=normal payment
YPTS=yearly potential tax savings
NPMDY=number of payments made during year.

Disclaimer:      

Every person's tax situation is different.    The figures listed here make a lot of assumptions about your tax situation. 
Use the estimates to give you a feel for what difference a home mortgage might make for an "average" person.    
We strongly recommend you consult an accountant or qualified tax consultant for specifics concerning your possible
tax savings!



What is Shareware?
Shareware is copyrighted commercial software that you are allowed to try out before you 
make the purchase decision.    It is a marketing concept, not a type of software.

Shareware marketing is typically used when the author doesn't have a huge advertising 
budget.    High end software like Lotus 1-2-3, dBase IV, etc. may have advertising budgets of 
over a million dollars.    A full page advertisement in a magazine like PC Magazine can cost 
over $10,000 an issue.    Smaller software companies, like MaeDae Enterprises, usually don't 
have that type of advertising budget so shareware marketing is used.

Many people question whether software distributed via shareware is of as high a quality as 
the software they see advertised in commercial magazines.    Good commercial advertising 
can sell almost any software regardless of its quality.    Shareware must be of equal or higher 
quality than commercially available software for users to register.    You, the user, have the 
opportunity to evaluate the shareware and find the real gems.    With commercial software, 
you purchase the software and then hope it works as advertised.    

Note:  Don't feel guilty about passing around copies of shareware.    You are helping the author distribute his 
software.    Even though shareware is commercial software, you are encouraged to pass around evaluation copies!



Registration Benefits
Registration benefits include:

1.    The latest version of    Mortgage Designer with no additional information screens.
2.    Unlimited support - written or by phone.
3.    Low cost upgrades.
4.    Notification of enhancements.
5.    A Windows based installation program is included with the registered version of 
Mortgage Designer.    It completely automates the installation process including the 
creation of a program group!
6.    Mortgage Designer now comes with a hard copy manual.    Previously this was a $10 
option.

Note:    Shareware relies on you, the user, for its existence.    Your registration will help ensure Mortgage Designer
continues to improve.    When you register, please take the time to fill out the suggestion form.    We want 
Mortgage Designer to evolve so it can better meet your needs.


